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About this book

This book describes IBM® Diagnostic Data Capture 1.0. You can use this product to
monitor and analyze memory dumps for supported IBM @server® xSeries®
servers.

How this book is organized

[Chapter 1, “Introducing Diagnostic Data Capture,” on page 1| contains an overview
of Diagnostic Data Capture, including its components and features.

[Chapter 2, “Installing Diagnostic Data Capture,” on page 7| details the system
requirements for Diagnostic Data Capture. This chapter also describes how to
install and uninstall Diagnostic Data Capture on management servers and client
systems.

[Chapter 3, “Configuring the management server,” on page 17| describes how to add
and remove client systems to and from the management server, how to stop
monitoring a client system, and how to configure memory dump settings for the
management server.

|Chapter 4, “Managing memory dumps,” on page 25| describes notifications of
memory dumps, location of memory dump files, how to analyze and manage
memory dump files, and the log files that are generated by Diagnostic Data

Capture. This chapter also explains how to uncompress memory dump files.

[Appendix A, “Terminology summary and abbreviation list,” on page 31|contains a
summary of Diagnostic Data Capture terminology and a list of abbreviations that are
used in Diagnostic Data Capture documentation.

IAppendix B, “Getting help and technical assistance,” on page 33| contains
information about accessing IBM Support Web sites for help and technical
assistance.

lAppendix C, “Notices,” on page 35| contains product notices and trademarks.

The [‘Glossary” on page 37| provides definitions for terms that are used in Diagnostic
Data Capture documentation.

Notices that are used in this book

This book contains the following notices designed to highlight key information:
* Note: These notices provide important tips, guidance, or advice.

» Important: These notices provide information or advice that might help you avoid
inconvenient or difficult situations.

» Attention: These notices indicate possible damage to programs, devices, or
data. An attention notice is placed just before the instruction or situation in which
damage could occur.

© Copyright IBM Corp. 2004 vii



Diagnostic Data Capture documentation

The Web site for Diagnostic Data Capture provides the Diagnostic Data Capture 1.0
Installation and User’s Guide in Adobe Acrobat Portable Document Format (PDF).

You can also obtain this document from the IBM Support Web site at
lhttp://www.ibm.com/pc/support/

Additionally, the Remote Supervisor Adapter Il, User’s Guide might be of interest.
You can obtain this documentation from the IBM Support Web site.

Diagnostic Data Capture resources on the World Wide Web

The following Web pages provide resources for understanding, using, and
troubleshooting IBM xSeries servers and products.

IBM Support page
http://www.ibm.com/pc/support/|

This is the IBM Support Web site for IBM hardware and
systems-management software. For systems-management software
support, click Systems management.

IBM Systems Management Software: Download/Registration page
Ihttp://www.ibm.com/pc/us/eserver/xseries/systems_management/dwnl.html|

Use this Web page to download IBM systems-management software,
including IBM Director.

IBM xSeries Systems Management page
bttp://www.ibm.com/pc/ww/eserver/xseries/systems_management/index.html

This Web page presents an overview of IBM systems management and
IBM Director.

IBM ServerProven® page
http://www.ibm.com/pc/us/compat/index.htmi

This Web page provides information about IBM hardware compatibility with
IBM systems-management software.
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Chapter 1. Introducing Diagnostic Data Capture

IBM Diagnostic Data Capture is a program that captures, analyzes, and manages
memory dumps that are generated from operating-system failures on supported
xSeries systems. With these features, Diagnostic Data Capture can help you reduce
problem-determination time and enable trend analysis.

Diagnostic Data Capture uses the features of Microsoft® Windows® 2003 and the
Remote Supervisor Adapter Il to capture all memory dumps. By using the Remote
Supervisor Adapter Il as a secondary memory dump logging device, Diagnostic
Data Capture is able to acquire memory dumps that occur on multiple servers.
Diagnostic Data Capture transfers these memory dumps to a remote server so you
can debug the memory dump without directly accessing the server that originated
the memory dump.

Diagnostic Data Capture has two software components that are installed on
different servers in your network:

» Diagnostic Data Capture Server is installed on the server that you want to use as
the management server. This component provides a system tray control, a
graphical user interface, and a listener service. For more information, see
[‘Diagnostic Data Capture Server” on page 3|

» Diagnostic Data Capture Client Driver is installed on every client system that you
want to monitor for memory dumps. For more information, see[‘Diagnostic Data|
[Capture Client Driver” on page 6

[Figure 1 on page 2| provides an overview of a server network that uses Diagnostic
Data Capture.

© Copyright IBM Corp. 2004 1



All Remote Supervisor Management server
Adapter lls are connected
to the management server

through an Ethernet LAN Diagnostic Data Capture Server installed;
storage for memory dumps from client systems

N

Client
systems

Client
systems

Diagnostic Data Capture Client Driver
installed on each client system

Figure 1. Overview of Diagnostic Data Capture

Notes:

1. Service-processor networks that are using Dynamic Host Configuration Protocol
(DHCP) must also use Domain Name Service (DNS). If the network uses only
DHCP, Diagnostic Data Capture Server configures static Internet protocol (IP)
addresses for the service processors on the client systems and for the
management server.

This becomes a problem when the IP address of a service processor or the
management server expires. When this happens, you must add the client
system to the management server again. Otherwise, Diagnostic Data Capture
can no longer collect memory dumps from that client system.

2. The management server and the service processors on the client systems must
all be members of the domain that includes the DNS server. Otherwise,
Diagnostic Data Capture Server configures static IP addresses for the service
processors on client systems and for the management server. When DHCP
renews the IP addresses for these servers, Diagnostic Data Capture Server will
be unable to communicate with the service processors. Alternatively, you can
configure all service processors and the management server to use static IP
addresses outside of the DHCP network.

2 xSeries Systems Management: IBM Diagnostic Data Capture 1.0 Installation and User's Guide



Diagnostic Data Capture Server

Diagnostic Data Capture Server provides a system tray control, a graphical user
interface, and a listener service. Together, these components provide all the
functionality of Diagnostic Data Capture on the management server.

System tray control

After you install Diagnostic Data Capture Server, the system tray on the
management server includes a Diagnostic Data Capture system tray control. This

system tray control is identified by the ®4 icon when the listener service is running.

(When the listener service is stopped, the !‘g icon is used for the system tray

control.) By right-clicking the icon for this system tray control, you can access
features of Diagnostic Data Capture Server as shown in|Figure 2|

Start liskener service
Skop liskener service
Start Diagnostic Data Capture Console

Help conkents
About Diagnostic Data Capkure

Remove system kray conkrol

Figure 2. Diagnostic Data Capture system tray control menu

If you do not want this system tray control in your Windows task bar, complete the
following steps to remove it:

1. Right-click the Diagnostic Data Capture system tray control.
2. Click Remove system tray control.

Diagnostic Data Capture Console

Diagnostic Data Capture Console provides a graphical user interface that you can
use to perform the following functions:

 |dentify client systems that the management server monitors for memory dumps
» Configure port and directory path settings for Diagnostic Data Capture Server

* View and analyze memory dumps that are collected from client systems

» Access the help system for Diagnostic Data Capture

Diagnostic Data Capture Console uses the Microsoft Debugging Tools for Windows
to open and analyze memory dump files.

Note: Debugging Tools for Windows is not part of Diagnostic Data Capture. You
must obtain this software directly from Microsoft. For more information, see
‘Installing Debugging Tools for Windows on the management server” on|

page 12.|

Starting Diagnostic Data Capture Console
Complete the following steps to start Diagnostic Data Capture Console:

1. Right-click the Diagnostic Data Capture system tray control.

2. Click Start Diagnostic Data Capture Console. The “Diagnostic Data Capture”
window opens.

You can also start Diagnostic Data Capture Console by clicking Start » Programs »
IBM Diagnostic Data Capture » IBM Diagnostic Data Capture Console.

Chapter 1. Introducing Diagnostic Data Capture 3



The “Diagnostic Data Capture” window

After you start Diagnostic Data Capture Console, the “Diagnostic Data Capture”
window opens and displays two panes. These panes provide a graphical user
interface for configuring client systems and managing memory dumps. [Figure 3]
shows a typical “Diagnostic Data Capture” window.

=
File ©Options Help
Listen I Host name I IP Address File Mame I Size | Lask Modified
e spl.myhost.city. com 0000 FirmLog_20040604_065353.lag 57342 60404 (6:53a)
FirmLog_20040604_072409,lag 58167 60404 (7:248)
|7 spl.myhost,city, com 1.1.1.1 FirmLog_20040604_103724,log 58347 5/04104 {10;37a)
) FirmLog_20040607_090036.log 59655 6/07/04 (9:00a)
v spz myhost.city.com z.z.2.2 FirmLog_20040607_094738.log AO606 B[07/04 (9:47a)
¥ spi3.myhost.city. com 2333 FirmLog_20040608_030131 log 82705 6/08/D4 (B:01a)
MemDump_20040601_130222Cu0t, bxt 5984 6/04/04 (6:48a)
(™) sp4.myhost.city.com 4.4.4.4 MemDump_20040604_065353.dmp 65536 6/04/04 (6:53a)
MemDump_20040604_072409,dmp 65536 6/04/04 (7:24a)
MemDump_20040604_07240900t, bt 5609 6/04/04 (3:01a)
MemDump_20040604_103724 ,dmp 65536 6/04/04 (10:37a)
MemDump_20040604_103724Cut, bxt 3062 6/08(04 (3:023)
MemDump_20040607_090035, dmp 65536 6/07/04 (9:008)
MemDump_20040607_09003500t, bxt 3062 /0804 (8:03a)
MemDump_z0040607_094738,dmp 65536 6/07/04 (9:473)
MemDump_20040608_075722. dmp 65536 6/08(04 (7:57a)
MemDump_20040605_080131.dmp 65536 60504 (8:01a)
MemDump_20040608_0801:31 00t Ext 3062 60504 (8:042)
MermDurnp_Out, bxt 585 603104 (3:01p)
< | Il | »

Figure 3. “Diagnostic Data Capture” window

The left pane identifies all the client systems that have been configured on the
management server. For each row, Diagnostic Data Capture indicates whether it is
monitoring the client system (if it is, the Listen check box is selected for the client
system), the host name of the client system, and the IP address of the client
system. For more configuration information, see [‘Adding client systems to the|
[management server” on page 17

The left pane also indicates whether the listener service is running and whether
Diagnostic Data Capture can communicate with the service processor of each client
system as follows:

 If all the Listen check boxes with check marks in the left pane have a normal
white background, the listener service is running and Diagnostic Data Capture
can communicate with the service processors in all the client systems.

» If all the Listen check boxes with check marks have a red background, the
listener service is stopped and Diagnostic Data Capture cannot communicate
with any service processors in the client systems.

» If some Listen check boxes with check marks have a white background and
some Listen check boxes with check marks have a red background, the listener
service is running, but Diagnostic Data Capture cannot communicate with the
service processors on those client systems indicated by the red background on
the Listen check boxes. This situation can happen when the service processor in
a client system is powered-off.

For more information about the listener service, see ['Listener service” on page 5

The right pane lists the memory dumps that have been gathered for the
management server and the memory dump reports that have been created. Each
row lists one memory dump or memory dump report. For each row, Diagnostic Data
Capture indicates the file name, the size of the file, and the file modification date.
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By default, Diagnostic Data Capture Server stores the files shown in the right pane
in the c:\DDC\WMemory_Dumps directory. For information about changing this
directory, see [‘Configuring default settings for the management server’ on page 21|

For more information about the location and naming convention that is used for
memory dumps, see [‘Finding memory dumps collected from client systems” on|
ipage 25.

Help system for Diagnostic Data Capture

The help system for Diagnostic Data Capture describes all components and
features of Diagnostic Data Capture, including the client driver, listener service, and
system tray functionality. The help system is provided in hypertext markup language
(HTML) files.

Use one of the following methods to access the help system:

» Start Diagnostic Data Capture Console; then, click Help » Contents in the
“Diagnostic Data Capture” window. Diagnostic Data Capture displays the table of
contents for the help system.

* Right-click the Diagnostic Data Capture system tray; then, click Help contents.
Diagnostic Data Capture displays the table of contents for the help system.

» Display an individual task window in Diagnostic Data Capture Console, for
example, the “Configuration settings” window; then, click Help. On those
windows, Diagnostic Data Capture displays context-specific help topics.

Use the links within a help topic and at the bottom of each help topic to navigate
the help system that is provided for Diagnostic Data Capture.

Listener service

The listener service runs in the background as an operating-system service. After
you install Diagnostic Data Capture Server, the listener service starts on the
management server. Further, the listener service automatically starts each time the
management server is started. When the listener service is running, it performs the
following functions:

» Listens to a designated port on the network for notifications that a memory dump
has occurred on a client system. For information about designating the port that
is used by the listener service, see [‘Configuring default settings for the|
[management server” on page 21

» After a notification occurs for a client system, retrieves the memory dump from
the client system and saves it to disk on the management server.

» After the memory dump is transferred to the management server, notifies
Diagnostic Data Capture Server that a new memory dump is available. For
details, see ['Memory dump notifications” on page 25.|

You can determine whether the listener service is running or stopped by examining
the icon for the Diagnostic Data Capture system tray control.[Table 1| describes the
icons that are used.

Table 1. System tray control icons for the listener service

Icon Description
% The listener service is running.
% The listener service is stopped.

Chapter 1. Introducing Diagnostic Data Capture 5



From the “Diagnostic Data Capture” window, you can determine the status of the
listener service by examining the Listen check box for each client system that is
configured. If the Listen check boxes with check marks have a normal white
background, the listener service is running. If the Listen check boxes with check
marks have a red background, the listener service is stopped.

You can also determine the status of the listener service by examining the services
that are available to the operating system on the management server. The
Diagnostic Data Capture listener service is identified as the IBMDDCService. To
access Windows services from the Control Panel, double-click Administrative
Tools and double-click Services.

Starting the listener service
Complete the following steps to start the listener service:

1. Right-click the Diagnostic Data Capture system tray control.
2. Click Start listener service.

Stopping the listener service
Complete the following steps to stop the listener service:

1. Right-click the Diagnostic Data Capture system tray control.
2. Click Stop listener service.

Diagnostic Data Capture Client Driver

6

Diagnostic Data Capture Client Driver is the component of Diagnostic Data Capture
that is installed on each supported client system that you want to monitor with
Diagnostic Data Capture Server. For information about the supported client
systems, see [‘Requirements for client systems” on page 8/

The client driver performs the following functions:
* Registers with the operating system as a device driver.

» Uses the service processor as a secondary dump device so it can receive
memory-dump data.

» Sends the memory dump to the listener service on the management server.

xSeries Systems Management: IBM Diagnostic Data Capture 1.0 Installation and User’s Guide



Chapter 2. Installing Diagnostic Data Capture

This chapter provides information about system requirements, supported servers
and operating systems, and instructions for installing and uninstalling Diagnostic
Data Capture 1.0.

System requirements

Diagnostic Data Capture has different requirements for management servers and
client systems.

Requirements for management servers

You can use Diagnostic Data Capture Server on any management server that is
running one of the following operating systems:

* Microsoft Windows XP Professional (Service Pack 1 or later required)

* Windows 2000 Professional, Server, and Advanced Server (Service Pack 3 or
later required)

* Windows Server 2003, Standard, Enterprise, Datacenter, and Web Editions

Diagnostic Data Capture Server requires a variable amount of disk space that is
based upon these factors:

* The number of client systems that you plan to configure for the management
server.

* The amount of memory on each client system.
* The type of memory dump configured for each client system.

Complete memory dumps are as large as the amount of memory in the system,
kernel memory dumps are smaller and contain only kernel and active process
memory, and small memory dumps, which are limited to 64 KB.

* The frequency of memory dumps that you anticipate for each client system.
* How long you want to retain the memory dumps on disk.

For example, if a client system is configured to produce full memory dumps and
that system has 1 GB of memory, any memory dump from that system will be 1 GB.
If you have 10 such systems configured for one management server, that
management server needs 10 GB of disk space for one memory dump from each
client system. If you anticipate that these systems will produce approximately one
memory dump per week and you intend to keep these memory dumps on disk for
only four weeks, you need 40 GB of disk space.

Notes:

1. You must make sure that the management server has enough disk space for
the memory dumps from the client systems. If there is not enough disk space,
Diagnostic Data Capture Server is unable to write the memory dump to disk on
the management server.

2. Aclient system that is configured for full memory dumps can create a memory
dump file that is equal to the amount of physical memory in the client system.
However, the operating system can limit a full memory dump on some systems
because of the amount of installed physical memory. Diagnostic Data Capture
cannot affect this operating-system limitation.

© Copyright IBM Corp. 2004 7



Requirements for client systems

You can use Diagnostic Data Capture Client Driver with xSeries 345 servers that
have a Remote Supervisor Adapter Il service processor. These servers must be
running Windows Server 2003 (Standard, Enterprise, Datacenter, or Web Edition).

Diagnostic Data Capture Client Driver requires a very minimal amount of disk
space.

Downloading Diagnostic Data Capture from the World Wide Web
Complete the following steps to download Diagnostic Data Capture from the IBM
Web site:
1. Go to pttp://www.ibm.com|
2. Click Support & Downloads.
3. Click Downloads & drivers.
4

In the Enter search terms field, type Diagnostic Data Capture and click
Submit.

Click Systems Management - Diagnostic Data Capture 1.0.
Click the file link for the executable file to download the file.

Additionally, you can download the ddc100_readme.txt file and the Diagnostic
Data Capture 1.0 Installation and User’s Guide from this Web page.

7. Copy the downloaded file to a local drive on each management server and
client system on which you want to install Diagnostic Data Capture.

oo

Installing Diagnostic Data Capture Server

Diagnostic Data Capture Server is the management component of Diagnostic Data
Capture. When it is installed on a server, it provides Diagnostic Data Capture
Console and the listener service. You have to install this component on only one
server in your network.

Complete the following steps to install Diagnostic Data Capture Server:

1. From the system on which you want to install Diagnostic Data Capture Server,
run the executable file that you downloaded.

Note: The operating-system account that is used to install Diagnostic Data
Capture Server must have at least local administrator authority.

The Diagnostic Data Capture Setup program starts, and the “Welcome to the
InstallShield Wizard for Diagnostic Data Capture” window opens.
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Data Capture - InstallShield Wizard x|

Welcome to the InstallShield Wizard for IBM
Diagnostic Data Capture

The IngtallShield® 'wizard will install IEM Diagnostic Data
Capture on wour computer. Ta continue, click Mest.

Cancel |

Figure 4. “Welcome to the InstallShield wizard” window

2. Click Next. The “License Agreement” window opens.

IBM Diagnostic Data Capture - InstallShield Wizard x|

License Agreement

Please read the following license agreement carefully.

International License Agreement for Mon-Warranted Programs il
Pait 1 - General Tems

B DOWNLOADING, INSTALLING, COPYING, ACCESSING, OR USING THE
FROGRAM YOU AGREE TO THE TERMS OF THIS AGREEMENT. IF YOU ARE
ACCEPTING THESE TERMS OM BEHALF OF ANOTHER PERSON OR A COMPANY
OF OTHER LEGAL ENTITY, YOU REPRESEMT AMD WARRANT THAT YOL HAVE
FULL AUTHORITY TO BIND THAT PERSON, COMPANY, OR LEGAL ENTITY TO
THESE TERMS. IF YOU DO NOT AGREE TO THESE TERMS.

-D0 NOT DOWHNLOAD, INSTALL, COPY. ACCESS. OR USE THE PROGRAM: AND ;I

" | accept the terms of the license agreement

% | do not accept the terms of the license agreement

IrstallShield

< Back I fExt > I Cancel

Figure 5. “License Agreement” window

3. Read the license agreement; then, click | accept the terms in the license
agreement and click Next. The “Select Features” window opens.

Chapter 2. Installing Diagnostic Data Capture 9
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IBM Diagnostic Data Capture - InstallShield Wizard

Select Features
Select the feature you want to install,

Please select the feature that you want to install.

] Diagnostic Data Capture Server sstup
Install this portion on the management server. It includes the Diagnostic
Data Capture Console and the Listener Service.
= Diagnostic Data Capture Client Driver setup
|_-I,. Install this portion on the client system. It enables the client system ta
communicate with the Listener Service on the management server.
IrstallShigld

< Back | fExt > I Cancel

Figure 6. “Select Features” window

4. Click the icon next to Diagnostic Data Capture Server. The “Added steps for
Diagnostic Data Capture Server install” window opens.

IBEM Diagnostic Data Capture - InstallShield Wizard

Added steps for Diagnostic Data Capture Server install

Diagnostic Data Capture Server prerequisites:

To complete the configuration, you must download and install the Microsoft Debugging Tools.
Alzo, access iz required to either the Microsoft Symbol Server or a site-specific symbal server.
Otherwise, the memory dump files cannot be analyzed,

Obtain the Microzoft Debugging Tools for Windaws from this ‘Web address:
hittp: v microsoft. comAwhde/ddk /debugging/default. mspx

For information about the Microsoft Symbol Server, see this web addiess:

hittp: A fv, microzoft. comAwhde/devtools/debugging/ symbols. mepx

IristallS hield

< Back | Mest > I Cancel I

Figure 7. “Added steps for Diagnostic Data Capture Server install” window

5. If necessary, write down the Web addresses for the Microsoft Debugging Tools
for Windows and the Microsoft Symbol Server. For more information, see
[‘Completing the installation on a management server’ on page 12|

6. Click Next. The “Choose Destination Location” window opens.

xSeries Systems Management: IBM Diagnostic Data Capture 1.0 Installation and User’s Guide



IBM Diagnostic Data Capture - InstallShield Wizard

Choose Destination Location
Select folder where setup will install files.

Setup will install IBM Diagnostic D ata Capture in the following folder.

Tainstall to this folder, click Mext. To install to a different folder, click Browse and select
another folder.

Destination Folder
(E:\Progtam Filess|BM\IEM Diagnostic Data Capture Browse... |
IrstallShigld

< Back I MNext > I Cancel |

Figure 8. “Choose Destination Location” window

7. Click Next. The “Setup Status” window opens.

IBM Diagnostic Data Capture - InstallShield Wizard

Setup Status

|BM Diagnostic D ata Capture is configuring your new software ingtallation.

Ingtalling

C:%Pragram Files\EMABM Diagnostic Data Capture\DDClistener. exe

IrstallShigld

Cancel

Figure 9. “Setup Status” window

When the installation is completed, the “InstallShield Wizard Complete” window
opens.
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IBM Diagnostic Data Capture - InstallShield Wizard

InstallShield Wizard Complete

The InstallShield Wizard has successfully installed 1B
Diagnostic Data Capture, Click Finish to exit the wizard.

< Back | Finish I Cancel

Figure 10. “InstallShield Wizard Complete” window

8. Click Finish.

Completing the installation on a management server

Before you can use Diagnostic Data Capture Server to analyze memory dumps that
are captured from client systems, you must download and install the Microsoft
Debugging Tools for Windows onto the management server that you are using.
Additionally, you must understand how Diagnostic Data Capture Server uses the
Microsoft Symbols Server.

Installing Debugging Tools for Windows on the management server

Complete the following steps to download and install the Microsoft Debugging Tools
for Windows software:

1. Go to http://www.microsoft.com/whdc/devtools/debugging/default.mspx}

2. Click the link for the current release of the Debugging Tools for Windows 32-bit
versions.

3. Follow the instructions to download and install the debugging tools on the
management server. Diagnostic Data Capture was tested for use with version
6.2.13.1 from 18 July 2003. Later versions of the debugging tools might work,
however, changes to commands and command syntax could affect the
operation of Diagnostic Data Capture.

Using the Windows Symbol Server on the management server

By default, Diagnostic Data Capture configures the management server to use the
Microsoft Windows Symbol Server that is accessed over the Internet. This symbol
server provides the Windows symbol files that are needed when a memory dump
file is analyzed with the Debugging Tools for Windows. For more information about
the Microsoft Symbol Server, see
lIhttp://www.microsoft.com/whdc/devtools/debugging/symbols.mspx}

If your management server does not have Internet access, you can configure
Diagnostic Data Capture Server to use a site-specific symbol server. For details,
see [‘Configuring default settings for the management server” on page 21/
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Installing Diagnostic Data Capture Client Driver

Diagnostic Data Capture Client Driver provides the client driver component of
Diagnostic Data Capture. When the client driver is installed on a server, it captures
memory dumps that can be sent to Diagnostic Data Capture Server. This
component of the product must be installed on every system in your network that
you plan to monitor with Diagnostic Data Capture.

Note: Only windows that are unique to the installation of Diagnostic Data Capture
Client Driver are illustrated in the following procedure. If a window is not
shown, see [‘Installing Diagnostic Data Capture Server” on page 8|for an
example of the window.

Complete the following steps to install Diagnostic Data Capture Client Driver:

1. From the system on which you want to install Diagnostic Data Capture Client
Driver, run the executable file that you downloaded.

Note: The operating-system account that is used to install Diagnostic Data
Capture Client Driver must have at least local administrator authority.

The Diagnostic Data Capture Setup program starts, and the “Welcome to the
InstallShield Wizard for Diagnostic Data Capture” window opens.

2. Click Next. The “License Agreement” window opens.

3. Read the license agreement; then, click | accept the terms in the license
agreement and click Next. The “Select Features” window opens.

4. Click the icon next to Diagnostic Data Capture Client Driver. The “Added steps
for Diagnostic Data Capture Client Driver” window opens.

IBM Diagnostic Data Capture - InstallShield Wizard x|

Added steps for the Diagnostic D ata Capture Client Driver * y

Diagnostic D ata Capture Client Driver prerequisites:

The client system must include the latest version of the xSeries spstem BIOS and the latest
wersion of the Remote Supervizor Adapter |l firmware, Othernwize, the client driver cannot
cammunicate with the Listener Service on the management server.

Obtain the latest xSeries system BIOS from this Web address:
hittp: / Avwe-1.ibm. comdservers/eserver/supportsenies/indes. html

Obtain the latest Remote Supervison Adapter || firmware update from this Web address:

hittp: / Avwan-1.ibm. com/servers/eserver/supportAxseries/index. html

[nstallShield

< Back

Figure 11. “Added steps for Diagnostic Data Capture Client Driver” window

5. If necessary, write down the Web addresses for the latest xSeries system basic
input/output system (BIOS) and the latest Remote Supervisor Adapter Il
firmware. For more information, see [‘Completing the installation on a clientl
[system” on page 14

6. Click Next. The “Setup Status” window opens, and the client driver component
is saved with the other operating-system drivers, usually in
c:\windows\system32\drivers.
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During the installation, the “Security Alert - Driver Installation” window opens.
This window opens because Microsoft does not provide the client driver for
Diagnostic Data Capture.

Security Alert - Driver Installation x|

[@ The driver software you are installing for:

|IEM Diagnastic D ata Capture

has been signed with Authenticode(TM) technology. The publisher's identity
has been verified, and the driver has not been modified since it was published.

Published by: |BM
Date published: E/3/2004
Publisher authenticity verified by YeriSign Class 3 Code Signing 2001 Ca

However, this diiver cannot be tested by Microsoft Windows Hardware Quality
Labs to verify its compatibility with this version of Windows. [Tell me more about
this testing. |

Do you trust this publisher and want ko install the driver?

Yes | [HD I | More Info I

Figure 12. “Security Alert - Driver Installation” window

7. Click Yes to proceed with the client driver installation.

When the installation is completed, the “InstallShield Wizard Complete” window
opens.

8. Click Finish.

Completing the installation on a client system

Before you can use the Diagnostic Data Capture Client Driver to monitor a client
system for memory dumps, you must make sure that the client system includes the
latest versions of this software:

» xSeries system BIOS
* Remote Supervisor Adapter Il firmware

Otherwise, the client driver that is provided by Diagnostic Data Capture cannot
communicate with the listener service on the management server.

Complete the following steps to download and install this software:
1. Go to |http://www.ibm.com/servers/eserver/support/xseries/index.html|
2. Click Downloads to open the “Downloads & Drivers” page.

3. Under the “For any product” portion of the page, in the Family list, select
xSeries 345.

Click Continue.
In the View by document type list, select Downloads and drivers.
In the Filter by category list, select BIOS.

Click the name of the latest BIOS code for the selected family and download
the code.

Return the Web browser to the Support page for the selected family.
9. In the Filter by category list, select Remote Supervisor Adapter II.

N o o s

©
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10.

1.

12.

Click the name of the latest firmware for the Remote Supervisor Adapter I
from this list and download this firmware.

From the management server where you installed Diagnostic Data Capture
Server, run the two executable files that you downloaded.

Follow the installation instructions as directed.

Uninstalling Diagnostic Data Capture

Complete the following steps to uninstall Diagnostic Data Capture:

1.
2.
3.

IBEM Diagnostic Data Capture - InstallShield Wizard

Welcome

If Diagnostic Data Capture Console is running, close it.
Click Start » Settings » Control Panel. The “Control Panel” window opens.

Double-click Add/Remove Programs. The “Add/Remove Programs” window
opens.

Click IBM Diagnostic Data Capture.

Click Remove. The InstallShield wizard for Diagnostic Data Capture starts, and

the “Welcome” window opens.

todify, repair, or remave the program.

|riztallS hield

Welcome to the |EM Diagnostic Data Capture Setup Maintenance program. This program lets
you modify the curent installation. Click one of the optiohs below,

i Madify

Select new program features to add or select curently installed features to
remove.

" Repair
ﬁ Reinstall all program features installed by the previous setup.

" Remove

@ Remaove allinstalled features.

< Back | Mext > I Cancel

Figure 13. “Welcome” window

Click Remove; then, click Next.

When prompted about the uninstallation not removing any memory dump files or

the client system list, click OK.

When prompted to remove Diagnostic Data Capture and all of its features, click

Yes. After Diagnostic Data Capture has been uninstalled, the “Maintenance
Complete” window opens.

Chapter 2. Installing Diagnostic Data Capture
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IBM Diagnostic Data Capture - InstallShield Wizard

Maintenance Complete

InstallShield Wizard has finished performing maintenance:
operations on |BM Diagnostic D ata Capture,

< Back I Finist I Cancel

Figure 14. “Maintenance Complete” window

If any of the Diagnostic Data Capture files are in use during the uninstallation,
you must restart your server to remove these files. In this case, the
“Maintenance Complete” window notifies you of this information.

Diagnostic Data Capture - InstallShield Wizard

Maintenance Complete

InstallShield Wizard has finished performing maintenance:
operations on Diagnostic Data Capture.

@ Yes, | want to restart my computer now.
€ No, | will restart my computer later.

FRemove any digks from their drives, and then click Finish to
complete setup.

< Back | Finist I Cancel I

Figure 15. “Maintenance Complete” window when a restart is required

9. Click Finish to restart the server or select No, | will restart my computer later
and click Finish.
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Chapter 3. Configuring the management server

This chapter describes how to add client systems to the management server and
how to configure the management server with various memory dump settings.

Adding client systems to the management server

You must add the host name or IP address of the service processor in each client
system to the management server before Diagnostic Data Capture can monitor and
collect memory dumps from that client system. When you do so, Diagnostic Data
Capture uses the service processor of the client system as a secondary dump
device. This enables the Diagnostic Data Capture Client Driver to notify the service
processor of memory dump events that the listener service on the management
server can act upon.

You can add client systems in several different ways. Regardless of the method that
you choose to add a client system to the management server, the client systems
will be added to those already configured for the management server. Further, the
newly added client systems are monitored for memory dumps. If you do not want to
monitor a newly added client system, see I“Stopping monitoring of a client system|
ffor memory dumps” on page 20|

Note: You can add a client system to the management server when the client
system does not have the Diagnostic Data Capture Client Driver installed.
However, no memory dumps are collected from that client system until you
also install the client driver on that client system.

Adding client systems by host name
Complete the following steps to add client systems by host name:

1. Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

2. Click File » Add service processor by host name. The “Add service processor
by host name” window opens.

IBM Diagnostic Data Capture - Add service prncess:féi' 21x|

Add a server to receive memory dump files,
The server can be added by entering its service processor host name.
Enter the Service Processor's Login ID and Password,

Service processor hosk name:

| [
Service processor login ID:

Login ID password:

QK I Cancel | Help |

Figure 16. “Add service processor by host name” window

© Copyright IBM Corp. 2004 17



3. In the Service processor host name field, type the host name of the service
processor on the client system that you want to monitor. For example, type
myhost or myhost.city.com.

4. In the Service processor login ID field, type the login ID for the service
processor.

5. In the Login ID password field, type the password for the login ID that you
used.

6. Click OK. It can take several seconds for Diagnostic Data Capture Server to
validate the host address when you are adding a client system.

Adding client systems by IP address
Complete the following steps to add client systems by IP address:

1. Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

2. Click File » Add service processor by IP address. The “Add service
processor by IP address” window opens.

IBM Diagnostic Data Capture - Add service proces . x|

Add a server to receive crash durnp files.
The server can be added by entering its service processor IP
address. Enter the Service Processor's Login ID and Password,

Service processor IP address:

Service processor login ID:

Login ID password:

QK I Cancel | Help |

Figure 17. “Add service processor by IP address” window

3. In the Service processor IP address field, type the IP address of the service
processor on the client system that you want to monitor. For example, type an
IP address in the format xxx.xXX.XXX.XXX.

4. In the Service processor login ID field, type the login ID for the service
processor.

5. In the Login ID password field, type the password for the login ID that you
used.

6. Click OK. It can take several seconds for Diagnostic Data Capture Server to
validate the host address when adding a client system.
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Importing a file of client systems

Complete the following steps to import a comma-separated values (CSV) file that
identifies client systems to monitor:

1.

IBM Diagnostic Data Capture - Import file of service proce: 0 ﬁl

Use an ASCII text editor, for example, Microsoft WordPad or Visual SlickEdit, to
create a CSV file that lists either the host names or the IP addresses of the
client systems that you want to monitor.

For example, you could create a file called clientlist.csv that identifies the client
systems that you want to monitor. The following example shows portions of a
file that defines client systems by host name:
financials.city.com,financials.com,financials
operations.city.com,operations.com,operations

The following example shows portions of a file that defines client systems by IP
address:

255.255.255.255,100.100.100.10

Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

Click File » Import file of service processor hosts. The “Import file of service
processor hosts” window opens.

Type in the name of the comma separated values File {.csv), This file should contain a
comma-separated list of service processor host names or service processor IP addresses that
identify the servers to receive memory dump files.

Filename:

Browse I

oK I Cancel | Help I

Figure 18. “Import file of service processor hosts” window

4.

In the Filename field, type the full path name of the CSV file that identifies the
client systems that you want to monitor. Alternatively, click Browse to navigate
to the file. Click the file name and click Open.

Click OK.

Diagnostic Data Capture reads through the CSV file to add the designated client
systems. For each client system that is added to the management server, the
“Service Processor Login ID and Password” window opens.
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1BM Diagnostic Data Capture - Service Processor Login ID and P 5[

Enter the service processor login 1D and password for myhost, city.com

Service processor login ID:

Login ID password:

oK I Cancel | Help |

Figure 19. Importing a file of client systems: “Service Processor Login ID and Password”
window

6.

9.

In the Service processor login ID field, type the login ID for the indicated
service processor.

In the Login ID password field, type the password for the login ID that you
used.

Click OK. Alternatively, you can click Cancel to skip the indicated service
processor and proceed to the next service processor in the CSV file. It can take
several seconds for Diagnostic Data Capture Server to validate the host
address when you are adding a client system.

Repeat steps [f through [§ until there are no more client systems to add.

Stopping monitoring of a client system for memory dumps

Complete the following steps to stop monitoring a client system for memory dumps:

1.

Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

In the Listen column in the left pane, clear the check box for the client system.
To begin monitoring the client system again, select the check box.

Updating the login ID or password for a service processor in a client

system

If the login ID or password of the service processor in a client system changes, you
must communicate this change to Diagnostic Data Capture Server. Otherwise, the
listener service will be unable to obtain memory dumps from that service processor.

Complete the following steps to update the login ID or password for a service
processor in a client system:

1.

Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

In the left pane, right-click the row for the client system; then, click Update
login ID and password. The “Service Processor Login ID and Password”
window opens.
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1BM Diagnostic Data Capture - Service Processor Login ID and P 5[

Enter the service processor login ID and password for myhost, city.com

Service processor login ID:

Login ID password:

oK I Cancel | Help |

Figure 20. Updating the login ID or password: “Service Processor Login ID and Password”
window

3.

4.

5.

In the Service processor login ID field, type the login ID for the indicated
service processor.

In the Login ID password field, type the password for the login ID that you
used.

Click OK.

Deleting a client system from the management server

Complete the following steps to delete a client system from the management
server:

1.

Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

In the left pane, right-click the row for the client system; then, click Delete
service processor. A window opens prompting you to confirm the deletion.

Click Yes to remove the configuration of the client system from the management

server.

Configuring default settings for the management server

Diagnostic Data Capture Server is preconfigured with default values for the
configuration settings on the management server. You can view or change the
configuration settings by using the “Configuration settings” window.

Complete the following steps to view or change the configuration settings for
Diagnostic Data Capture Server:

1.

Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

Click Options » Configuration settings. The “Configuration settings” window
opens.

Chapter 3. Configuring the management server
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IEM Diagnostic Data Capture - Configuration settin: ﬁl

‘fou can change these configuration settings or use the default values.

Port used by Listener Service:

4197

Path to Microsoft Windows Debugger:

I C:\Program Files\Debugging Tools for Windows

Symbol path (directory or server):

I sty *http: fimsdl. microsoft. com/download/symbals

Path to memory dumps:
I C:\DDCMemary _Dumps

QK I Cancel | Help

Figure 21. “Configuration settings” window

3. If necessary, change the values in any of the fields.

Port used by Listener Service

By default, the listener service uses port 4197 to copy memory dumps
from the client systems to the management server. The port number
that is configured for the management server must be the same port
number that is configured for the service processor of each client
system that you plan to use. The port number must be a number from
1025 through 65535. It can take several seconds for Diagnostic Data
Capture to update the port number that is used by the listener service.

Path to Microsoft Windows Debugger:
By default, Diagnostic Data Capture Server looks for the Debugging
Tools for Windows in the c:\Program Files\Debugging Tools for Windows
directory. If the debugging tools are in a different directory, update this
field with that directory path.

Symbol path (directory or server)
By default, Diagnostic Data Capture Server uses the Microsoft Symbol
Server, which is accessed over the Internet as needed during analysis
of a memory dump file. Alternatively, you can set up and use your own
symbol server by downloading all the Microsoft Windows Symbols into a
local directory and designating that directory in the Symbol path field.

Note: Diagnostic Data Capture cannot verify the accuracy of the
directory or server path that you enter in the Symbol path field.
For this reason, you must make sure that you have entered it
correctly. Otherwise, Diagnostic Data Capture will be unable to
analyze memory dump files.

For more information about the Microsoft Symbol Server, see
[http://www.microsoft.com/whdc/devtools/debugging/symbols.mspx,.
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Path to memory dumps
By default, the directory under which to save memory dumps that are
gathered from client systems is the \DDC\Memory_Dumps directory on
the system drive of the management server. If you change this to a
directory on a network share, you must make sure that the management
server itself (not a specific user account) has valid permissions to write
to the network share. Otherwise, Diagnostic Data Capture will be unable
to save memory dumps to the path that you designate.

4. Click OK.
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Chapter 4. Managing memory dumps

Use Diagnostic Data Capture to manage memory dumps on supported xSeries
systems. This chapter provides information about the following topics:

* Memory dump notifications

» Finding memory dumps collected from client systems

* Managing memory dumps with Diagnostic Data Capture Console
» Examining event log files from client systems

* Uncompressing memory dump files

Memory dump

notifications

When the listener service is running and a memory dump occurs on a configured
client system, Diagnostic Data Capture displays a message in Diagnostic Data
Capture Console to notify you as shown in [Figure 22

Diagnostic Data Capture x|

& Mew memary durnp File Far hast name: myhosk

Figure 22. Memory dump notification message

To close this message, click OK.

When a memory dump occurs, Diagnostic Data Capture Server also displays a
notification icon on top of the Diagnostic Data Capture system tray control. The

¥4 icon is removed automatically when you close the memory dump notification

message.

Finding memory dumps collected from client systems

When memory dumps are copied to the management server, they are copied to a
directory that is unique to each client system. The following naming convention is
used for these memory dump directories:

d\dump_directorAUUID

where

» dis the drive letter of the hard disk drive where the memory dump files are
written. By default, this is the system drive directory.

* dump_directory is the directory where the memory dump files are written. By
default, this is \DDC\Memory Dumps. For information about changing this
directory, see [‘Configuring default settings for the management server” on page]

» UUID is the universal unique identifier (UUID) that is used to identify the service
processor in the client system, for example, a4e9ea9c43b44a128ffe38c8bae8fff.
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Within each client system directory on the management server, the listener service
uses the following naming convention for memory dump files that it copies from the
client system:

MemDump_YYYYMMDD_HHMMSS.dmp

where

* YYYYMMDD is the year, month, and date when the memory dump file was
created. For example, the date 20040503 means the file was created 3 May
2004.

* HHMMSS is the hour, minute, and second when the memory dump file was
created. For example, the time 161648 means that the file was created at 48
seconds past 4:16 p.m.

For example, the file name for a memory dump could be C:\DDC\Memory_Dumps\
a4e9ea9c43b44a128ffe38c8bae8foffiMemDump_20040423_104837421.dmp.

For information about using Diagnostic Data Capture Console to view these
memory dump files, see|‘Analyzing a memory dump to create a memory dump|
report” on page 27| and ['Viewing a memory dump report created from analysis of a|
memory dump file” on page 27,

Sometimes the management server does not have sufficient disk space for
Diagnostic Data Capture to uncompress a memory dump file after it has been
transferred from a client system. In this case, you must manually uncompress the
file before you can manage it in Diagnostic Data Capture Console. For more
information, see[‘Uncompressing memory dump files” on page 29|

Managing memory dumps with Diagnostic Data Capture Console

From the Diagnostic Data Capture Console, you can perform the following
management functions:

* Open a memory dump in Debugging Tools for Windows

* Analyze a memory dump to create a memory dump report

* View a memory dump report created from analysis of a memory dump
« Save a file under a different name

* Delete a file from the management server

Opening a memory dump in Debugging Tools for Windows

Complete the following steps to open a memory dump in the “Debugger Command”

window provided by Debugging Tools for Windows:

1. Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

2. In the left pane, click the name of the client system that contains the memory
dump file that you want to open. The right pane lists all the files that Diagnostic
Data Capture has saved for that client system.

3. In the right pane, right-click the name of the memory dump file that you want to
open; then, click Open.
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Diagnostic Data Capture opens the file in the “Debugger Command” window of the
Debugging Tools for Windows. For information about using Debugging Tools for
Windows or any of the prompts that it displays, see the documentation provided for
it by Microsoft.

Analyzing a memory dump to create a memory dump report

Complete the following steps to analyze a memory dump and create a memory

dump report:

1. Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

2. In the left pane, click the name of the client system that contains the memory
dump file that you want to analyze. The right pane lists all the files that
Diagnostic Data Capture has saved for that client system.

3. In the right pane, right-click the name of the memory dump file that you want to
analyze; then, click Analyze. The “Analyze memory dump” window opens.

IBM Diagnostic Data Capture - Analyze memory dump - il

Diagnostic Data Capture will run the Debugging Toals For Windows to analyze the memory dump File,
The resulks from the analysis are written ko a text file called a memory dump report.

Memary dump report:

CADDCMemory _DumpsiuuidliMemDump_uuidl_20040519_15154100k, Ext

Ok I Cancel Help

Figure 23. “Analyze memory dump” window

4. In the Memory dump report field, type the name that you want to use for the
text report that is generated from the analysis of the memory dump. By default,
the name of the memory dump file is used. Diagnostic Data Capture Server
generates a text file that contains the memory dump report and displays its
name in the “Diagnostic Data Capture” window.

5. Click OK.

Viewing a memory dump report created from analysis of a memory
dump file

Complete the following steps to view a memory dump report from Diagnostic Data

Capture Console:

1. Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

2. In the left pane, click the name of the client system that contains the memory
dump report that you want to view. The right pane lists all the files that
Diagnostic Data Capture has saved for that client system.
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3. In the right pane, right-click the name of the text file that contains the memory
dump report that you want to view; then, click Open. Diagnostic Data Capture
opens the selected text file in Microsoft Notepad.

Saving a file with a different name

Complete the following steps to save a memory dump file or memory dump report

with a different name:

1. Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

2. In the left pane, click the name of the client system that contains the file that
you want to save with a different name. The right pane lists all the files that
Diagnostic Data Capture has saved for that client system.

3. In the right pane, right-click the name of the file that you want to save with a
different name; then, click Save as.

Deleting a file from the management server

Complete the following steps to delete a file from the management server:

1. Right-click the Diagnostic Data Capture system tray control; then, click Start
Diagnostic Data Capture Console. The “Diagnostic Data Capture” window
opens.

2. In the left pane, click the name of the client system that contains the file that
you want to delete. The right pane lists all the files that Diagnostic Data Capture
has saved for that client system.

3. In the right pane, right-click the name of the file that you want to delete; then,
click Delete.

Examining event log files from client systems

Every time Diagnostic Data Capture collects a memory dump from a client system,
it also collects the event log from the service processor on that client system. The
event log file is saved to the management server in the same directory as its
corresponding memory dump file. That is, the event log file is saved to the following
directory:

d:\dump_directonAN\UUID

where

» dis the drive letter of the hard disk drive where the memory dump files are
written. By default, this is the system drive directory.

* dump_directory is the directory where the memory dump files are written. By
default, this is \DDC\Memory Dumps. For information about changing this
directory, see [‘Configuring default settings for the management server” on page|

« UUID is the universal unique identifier (UUID) that is used to identify the service
processor in the client system, for example, a4e9ea9c43b44a128ffe38c8bae8fIff.
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Diagnostic Data Capture names these event log files with the following naming
convention:

FirmLog_YYYYMMDD_HHMMSS.log

where

* YYYYMMDD is the year, month, and date when the log file was created. For
example, the date 20040507 means the file was created 7 May 2004.

* HHMMSS is the hour, minute, and second when the log file was created. For
example, the time 145542 means that the file was created at 42 seconds past
2:55 p.m.

Figure 24|shows a portion of the event log from a client system.

System Tog cleared by user USERID.
Remote Login Successful. Login ID:''USERID' from CMD mode client at IP@=1.23.45.67'
Recovery System error log full

Figure 24. Sample event log from a client system

You can use any ASCII editors to view the event log file, although some, like
Microsoft WordPad and Visual SlickEdit, handle the line returns and special
characters in these event logs better than others like Microsoft Notepad.

The transferred event logs are the same event logs that you can view by using the
Web interface to remotely access the service processor on a client system. For
information about using this alternative method, see the Remote Supervisor Adapter
II: User’s Guide.

You can examine the messages in the event log to help solve any problems that
you might be having while capturing memory dumps. For example, if a memory
dump occurs for a client system and there is insufficient disk space available on the
management server, Diagnostic Data Capture Client Driver logs a message to the
event log. For information about disk space requirements, see
requirements” on page 7|

Uncompressing memory dump files

Sometimes the management server does not have sufficient disk space for
Diagnostic Data Capture to uncompress a memory dump file after it has been
transferred from a client system. In this case, you must manually uncompress the
file before you can manage it in Diagnostic Data Capture Console.

Note: Before you manually uncompress a memory dump file, you must free up
sufficient disk space on the management server.

A compressed memory dump file is written to the same directory as the
uncompressed memory dump files. The file naming convention is also the same
except .gz is the file extension that is used for a compressed memory dump file.
For more information on the dump directory and the file naming convention, see
[‘Finding memory dumps collected from client systems” on page 25|
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Use the minigzip command from a command prompt to manually uncompress a
.gz file and create its corresponding .dmp file. This command has the following
syntax:

minigzip -d memory_dump_file_name.dmp.gz

where
* memory_dump_file_name is the name of the file that contains the compressed
memory dump that you want to uncompress.

After the memory dump has been uncompressed and is created with the .dmp
extension, you can manage it using Diagnostic Data Capture Console.
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Appendix A. Terminology summary and abbreviation list

This appendix provides a summary of Diagnostic Data Capture terminology and a
list of abbreviations that are used in this documentation.

Diagnostic Data Capture terminology summary

The hardware in a Diagnostic Data Capture environment is referred to in the
following ways:

A management server is a server on which Diagnostic Data Capture Server is
installed.

A client system is a system on which Diagnostic Data Capture Client Driver is
installed.

The following software concepts are applicable to Diagnostic Data Capture:

Diagnostic Data Capture Server is the server-side component of Diagnostic Data
Capture. When it is installed on a management server, it provides Diagnostic
Data Capture Console and the listener service.

Diagnostic Data Capture Console is the graphical user interface on the
management server that provides configuration and management features for
memory dumps gathered from client systems.

The listener service is the feature of Diagnostic Data Capture Server that
monitors client systems for memory dumps, saves the memory dumps to the
management server, and notifies the management server that a new memory
dump is available.

The system tray control is the feature of Diagnostic Data Capture Server that
provides management functionality for Diagnostic Data Capture in the Windows
task bar.

Diagnostic Data Capture Client Driver is the client-side component of Diagnostic
Data Capture. When the client driver is installed on a server, it captures memory
dumps that can be sent to Diagnostic Data Capture Server.

Abbreviation list

The following table lists abbreviations that are used in the Diagnostic Data Capture

documentation.

Abbreviation Definition

BIOS basic input/output system
Ccsv comma-separated value
DHCP Dynamic Host Configuration Protocol
DNS Domain Name System

GB gigabyte

KB kilobyte

HTML hypertext markup language
IP Internet protocol

PDF Portable Document Format
uuID universal unique identifier

© Copyright IBM Corp. 2004
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Appendix B. Getting help and technical assistance

If you need help, service, or technical assistance or just want more information
about IBM® products, you will find a wide variety of sources available from IBM to
assist you. This appendix contains information about where to go for additional
information about IBM and IBM products, what to do if you experience a problem
with your xSeries or IntelliStation® system, and whom to call for service, if it is
necessary.

Before you call

Before you call, make sure that you have taken these steps to try to solve the
problem yourself:

» Check all cables to make sure that they are connected.
* Check the power switches to make sure that the system is turned on.

» Use the troubleshooting information in your system documentation, and use the
diagnostic tools that come with your system. Information about diagnostic tools is
in the Hardware Maintenance Manual and Troubleshooting Guide on the IBM
xSeries Documentation CD or in the IntelliStation Hardware Maintenance Manual
at the IBM Support Web site.

+ Go to the IBM Support Web site at |ttp://www.ibom.com/pc/support/| to check for

technical information, hints, tips, and new device drivers or to submit a request
for information.

You can solve many problems without outside assistance by following the
troubleshooting procedures that IBM provides in the online help or in the
publications that are provided with your system and software. The information that
comes with your system also describes the diagnostic tests that you can perform.
Most xSeries and IntelliStation systems, operating systems, and programs come
with information that contains troubleshooting procedures and explanations of error
messages and error codes. If you suspect a software problem, see the information
for the operating system or program.

Using the documentation

Information about your IBM xSeries or IntelliStation system and preinstalled
software, if any, is available in the documentation that comes with your system.
That documentation includes printed books, online books, readme files, and help
files. See the troubleshooting information in your system documentation for
instructions for using the diagnostic programs. The troubleshooting information or
the diagnostic programs might tell you that you need additional or updated device
drivers or other software. IBM maintains pages on the World Wide Web where you
can get the latest technical information and download device drivers and updates.
To access these pages, go to |hitp://www.ibm.com/pc/support]| and follow the
instructions. Also, you can order publications through the IBM Publications Ordering
System at
Ihttp://www.elink.ibmlink.ibm.com/public/applications/publications/cgibin/pbi.cgi.
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Getting help and information from the World Wide Web

On the World Wide Web, the IBM Web site has up-to-date information about IBM
xSeries and IntelliStation products, services, and support. The address for IBM
xSeries information is |http://www.ibm.com/eserver/xseries]| The address for IBM
IntelliStation information is |http://www.ibm.com/pc/intellistation/}

You can find service information for your IBM products, including supported options,
at|http://www.ibm.com/pc/support/

Software service and support

34

Through IBM Support Line, you can get telephone assistance, for a fee, with usage,
configuration, and software problems with xSeries servers, IntelliStation
workstations, and appliances. For information about which products are supported
by Support Line in your country or region, go to
Ihttp://www.ibm.com/services/sl/products/

For more information about Support Line and other IBM services, go to
http://www.ibm.com/services/, or go to |http://www.ibm.com/planetwide/ for support
telephone numbers. In the U.S. and Canada, call 1-800-IBM-SERV
(1-800-426-7378).
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Appendix C. Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may be
used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not give you any
license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation

North Castle Drive

Armonk, NY 10504-1785

U.S.A.

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply to
you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements and/or
changes in the product(s) and/or the program(s) described in this publication at any
time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this
IBM product, and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes
appropriate without incurring any obligation to you.

Some software may differ from its retail version (if available) and may not include all
user manuals or all program functionality.

IBM makes no representations or warranties regarding third-party products or
services.
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Edition notice

© COPYRIGHT INTERNATIONAL BUSINESS MACHINES CORPORATION, 2004.
All rights reserved.

U.S. Government Users Restricted Rights — Use, duplication or disclosure
restricted by GSA ADP Schedule Contract with IBM Corp.

Trademarks

The following terms are trademarks of International Business Machines Corporation
in the United States, other countries, or both:

e-business logo Netfinity
@server ServerProven
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Microsoft and Windows are trademarks of Microsoft Corporation in the United
States, other countries, or both.

Other company, product, or service names may be trademarks or service marks of
others.
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Glossary
B

basic input/output system (BIOS). The personal
computer code that controls basic hardware operations,
such as interactions with diskette drives, hard disk
drives, and the keyboard. The Configuration/Setup
Utility program is a menu-driven utility that is part of the
BIOS code that comes with a server. You can start it
with F1 during a specific point in the server startup (by
watching the screen for a message about it).

BIOS. See basic input/output system.

C

client system. The server on which Diagnostic Data
Capture Client Driver is installed. The IP address of the
service processor in a client system is configured in the
Diagnostic Data Capture Console so that the
management server can use the listener service to
capture and analyze memory dumps from the client
system.

D

Debugging Tools for Windows. Tools provided by
Microsoft that can analyze memory dump files from
systems running the Windows operating system.

Diagnostic Data Capture. The IBM stand-alone
program that can capture, analyze, and manage
memory dumps that are generated from operating
system failures on supported xSeries systems. It
includes two components: Diagnostic Data Capture
Server and Diagnostic Data Capture Client Driver.

Diagnostic Data Capture Client Driver. The client
driver component of Diagnostic Data Capture. When the
client driver is installed on a server, it captures memory
dumps that can be sent to Diagnostic Data Capture
Server.

Diagnostic Data Capture Console. The graphical
user interface on the Diagnostic Data Capture Server
that provides configuration and management features
for memory dumps gathered from client systems.

Diagnostic Data Capture Server. The management
component of Diagnostic Data Capture. When it is
installed on a server, it provides the Diagnostic Data
Capture Console and the listener service.

L

listener service. The feature of Diagnostic Data
Capture Server that monitors client systems for memory
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dumps, saves the memory dumps to the management
server, and notifies the management server that a new
memory dump is available.

M

management server. The server on which IBM
Diagnostic Data Capture Server is installed.

memory dump. The means by which the computer
system records its state at the time of a failure.

memory dump report. The text file created by
Diagnostic Data Capture Console that contains the
analysis of a memory dump. The information in this file
is created by Microsoft Windows Debugging Tools.

N

notification icon. The icon that is displayed over the
system tray control icon for Diagnostic Data Capture in
the Windows task bar to indicate that a memory dump
has occurred for one of the client systems configured in
Diagnostic Data Capture Server.

port. An end point for communication between
applications, generally referring to a logical connection.
A port provides queues for sending and receiving data.
Each port has a port number for identification. When the
port number is combined with an IP address, it is called
a socket address.

R

Remote Supervisor Adapter. An IBM service
processor. It is built into the system board of some
xSeries servers and is available as an optional adapter
for use with others. When it is used as an ASM
gateway, the Remote Supervisor Adapter can
communicate with all service processors on the ASM
interconnect.

S

service processor. A hardware-based management
processor that is used in IBM Netfinity® and xSeries
servers. A generic term for Remote Supervisor
Adapters, Advanced System Management processors,
Advanced System Management PCI adapters, and
integrated system management processors.

symbol server. A server that provides access to
Windows symbol files needed during memory dump
analysis. Diagnostic Data Capture can use the Microsoft
Symbols Server over the Internet or a site-specific
symbol server.
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system tray control. The feature of Diagnostic Data
Capture Server that provides management functionality
for Diagnostic Data Capture in the Windows task bar.

U

universal unique identifier (UUID). A 128-bit
character string guaranteed to be globally unique and
that is used to identify components under management.
The UUID enables inventory-level functionality and
event tracking of client systems.

UUID. See universal unique identifier.
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abbreviation list 31

Add service processor menu option
by host name 17
by IP address 18

Analyze menu option 27

C

client system 6
adding to the management server 17
by host name 17
by IP address 18
importing a CSV file 19
deleting 21
installation
Diagnostic Data Capture Client Driver 13
Remote Supervisor Adapter Il firmware 14
xSeries system BIOS 14
log files 28
example 29
naming convention 29
registering as secondary dump device 6
requirements 8
disk space 8
stopping monitoring 20
updating the login ID or password 20
console
See Diagnostic Data Capture Console
customer support viii

D

Debugging Tools for Windows
configuring 21
directory path 22
installing 12
Delete menu option 28
Delete service processor menu option 21
DHCP networks 2
Diagnostic Data Capture
client component 6
documentation  viii
installation 7
overview 1
server component 3
system requirements 7
uninstallation 15
Diagnostic Data Capture Console
help system 5
overview 3
starting 3
understanding 4
disk space requirements
client systems 8
management servers 7
DNS and service-processor networks 2
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documentation viii

domain, network 2

downloading software
Debugging Tools for Windows 12
Diagnostic Data Capture 8
Remote Supervisor Adapter Il firmware 14
xSeries system BIOS 14

E

Event log files 28
example 29
naming convention 29

H

hardware requirements
client systems 8
management servers 7
help
Diagnostic Data Capture help system 5
IBM Web sites viii

IBM Web sites viii
downloading Diagnostic Data Capture 8
Import file of service processor hosts menu option
installation
client system
Diagnostic Data Capture Client Driver 13
hardware requirements 8
Remote Supervisor Adapter Il firmware 14
software requirements 8
xSeries system BIOS 14
management server
Debugging Tools for Windows 12
Diagnostic Data Capture Server 8
hardware requirements 7
software requirements 7
Windows symbol server 12

L

Listen check box 4
listener service 5
configuring port used by 21
icons 5
port used by 22
starting 6
status in Diagnostic Data Capture Console 4
stopping 6
log files, event 28
example 29
naming convention 29
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management server 3 port for the listener service
configuring client systems 17 configuring 21

adding by host name 17 default port number 22
adding by IP address 18
deleting 21
importing a CSV file 19 R
stopping monitoring 20 Remote Supervisor Adapter II, downloading
updating the login ID or password 20 firmware 14

Diagnostic Data Capture Console 3
listener service 5

starting 6 S
stopping 6 Save as menu option 28

requirements 7 service processor
disk space 7 adding to the management server 17
system tray control menu 3 by host name 17
memory dump 25 by IP address 18
analyzing 27 importing a CSV file 19

configuring management server 21 communication problems 4

debugging tools 22

: deleting 21
deleting 28 event log files 28
directories 25 example 29

directory path 23
configuring 21
listener service port 22
managing 26
naming convention 26
notifications 25
opening 26
saving with a different name 28
symbol server 22
memory dump report

naming convention 29

stopping monitoring 20

updating the login ID or password 20
software requirements

client systems 8

management servers 7
support, customer viii
symbol server

configuring 21

. installing 12
creating 27 path to 22

deleting 28 system requirements 7
managing 26 system tray control
naming convention 27 help system 5
opening 27 menu 3

saving with a different name 28 removing 3

N T

network terminology 31
DHCE and DNS 2 trademarks 36
qugln 2 tray, system 3
notifications
memory dump message 25
system tray control icon 25 U
uninstallation 15
0 Update login ID and password menu option 20

Open menu option
memory dump file 26 W
memory dump report 27
operating system requirements
client systems 8
management servers 7

Windows

Debugging Tools
configuring 21
directory path 22
installing 12

symbol server
configuring 21
installing 12
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Windows (continued)
symbol server (continued)
path to 22

X

xSeries system BIOS
downloading 14

Index
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